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Disclaimer 

The information contained in this document is subject to change without notice. Minisoft, 

Inc. makes no warranty of any kind with regard to this material, including, but not limited 

to, the implied warranties of merchantability and fitness for a particular purpose. 

Minisoft, Inc. or its agents shall not be liable for errors contained herein or for incidental 

or consequential damages in connection with the furnishings, performance, or use of this 

material. 

This document contains proprietary information which is protected by copyright. All 

rights are reserved. No part of this document may be photocopied, reproduced, or 

translated to another programming language without the prior written consent of 

Minisoft, Inc. 

©1997-2007 by Minisoft, Inc., Printed in U.S.A. 

All product names and services identified in this document are trademarks or registered 

trademarks of their respective companies and are used throughout this document in 

editorial fashion only and are not intended to convey an endorsement or other affiliation 

with Minisoft, Inc. 
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License Agreement 

In return for payment of a onetime fee for this software product, the Customer receives 

from Minisoft, Inc. a license to use the product subject to the following terms and 

conditions: 

 The product may be used on one computer system at a time: i.e., its use is not 

limited to a particular machine or user but to one machine at a time. 

 The software may be copied for archive purposes, program error verification, or 

to replace defective media. All copies must bear copyright notices contained in 

the original copy. 

 The software may not be installed on a network server for access by more than 

one personal computer without written permission from Minisoft, Inc. 

Purchase of this license does not transfer any right, title, or interest in the software 

product to the Customer except as specifically set forth in the License Agreement, and 

Customer is on notice that the software product is protected under the copyright laws. 
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90-Day Limited Warranty 

Minisoft, Inc. warrants that this product will execute its programming instructions when 

properly installed on a properly configured personal computer for which it is intended. 

Minisoft, Inc. does not warrant that the operation of the software will be uninterrupted or 

error free. In the event that this software product fails to execute its programming 

instructions, Customerôs exclusive remedy shall be to return the product to Minisoft, Inc. 

to obtain replacement. Should Minisoft, Inc. be unable to replace the product within a 

reasonable amount of time, Customer shall be entitled to a refund of the purchase price 

upon the return of the product and all copies. Minisoft, Inc. warrants the medium upon 

which this product is recorded to be free from defects in materials and workmanship 

under normal use for a period of 90 days from the date of purchase. During the warranty 

period Minisoft, Inc. will replace media which prove to be defective. Customerôs 

exclusive remedy for any media which proves to be defective shall be to return the media 

to Minisoft, Inc. for replacement. 

ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS IS LIMITED 

TO THE 90-DAY DURATION OF THIS WRITTEN WARRANTY. Some states or 

provinces do not allow limitations on how long an implied warranty lasts, so the above 

limi tation or exclusion may not apply to you. This warranty gives you specific rights, and 

you may also have other rights which vary from state to state or province to province. 

LIMITATION OF WARRANTY: Minisoft, Inc. makes no other warranty expressed or 

implied with respect to this product. Minisoft, Inc. specifically disclaims the implied 

warranty of merchantability and fitness for a particular purpose. 

EXCLUSIVE REMEDIES: The remedies herein are Customerôs sole and exclusive 

remedies. In no event shall Minisoft, Inc. be liable for any direct, indirect, special, 

incidental, or consequential damages, whether based on contract, tort, or any other legal 

theory. 
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1. Introduction 

Which product is right for you? 

Minisoft provides a suite of products to allow cross platform access to information. No 

one size fits all or universal tool will permit the wide variety of applications and 

environments our customers need. The ODBC and JDBC drivers and the OLE DB data 

provider are standards based interfaces to access your data.  

All three products allow you read and write to TurboImage and Eloquence as if they were 

like any other database. They also support advanced features such as access to multiple 

databases, KSAM, flat, and MPE files. The server can be installed on MPE as well as 

many UNIX and Windows systems supporting Eloquence®, flat files, or Robelle® SD 

files.  

All Minisoft client server products can coexist on your server. This will  allow you to 

provide all the interfaces needed by your developers or software suppliers without 

concern for compatibility. 

What is ODBC? 

Open Database Connectivity (ODBC) is a standard or open application programming 

interface (API) for accessing a database. SQL statements will allow you to access files in 

a number of different databases. This includes MS Access, Excel, Impromptu, Lotus 

Approach, Visual Basic, Crystal Reports, FrontPage, Cold Fusion, Speedware, Esperant, 

Brio, Delphi, PowerBuilder, Active Server Pages, BusinessObjects, .NET etc. In addition 

to the ODBC software that is built into each compliant program, a separate module or 

driver will be needed for each database you want to access. 
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ODBC is based on and closely associated with the Open Group standard Structured 

Query Language (SQL) Call-Level Interface. ODBC allows programs to use SQL 

requests that will access databases without having to know the proprietary interfaces to 

the databases. ODBC handles the SQL request and converts it into a request the 

individual database system understands. 

What is JDBC? 

Java Database Connectivity Driver (JDBC) is a standard or open application-

programming interface (API) for accessing a database from JAVA programs. The 

Minisoft JDBC driver implements this API to give JAVA programs access to data in 

TurboImage and Eloquence® databases, KSAM files, MPE files, Self-describing files, 

and PowerHouse sub-files. 

JDBC is based on and closely aligned with the Open Group standard Structured Query 

Language (SQL) Call-Level Interface. It allows programs to use SQL requests that will 

access databases without having to know the proprietary interfaces to the databases. The 

JDBC driver handles the SQL request and converts it into a request the individual 

database system understands. 

What is OLE DB? 

"OLE DB" opens the door to a rich set of development tools and platforms for Microsoft 

Windows Servers. Microsoft has announced that OLE DB will be the method by which 

all information is accessed. The roadmap for future Microsoft applications requires using 

OLE DB data sources to "provide uniform access to data stored in diverse information 

sources". The Minisoft OLE DB Provider provides that access to your existing 

TurboImage and Eloquence databases. 

Use the Minisoft OLE DB Provider for Image/Eloquence to help solve the following 

problems:  

 Transparent access to your Image/Eloquence data from the 32-bit or 64-bit 
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editions of SQL Server 2005. 

 Integrate Image or Eloquence database access smoothly into your .NET 

application development environment. 

 Continue accessing Image or Eloquence data with Microsoft Visual Studio, 

Borland development tools, Microsoft Access (through VBA),Microsoft Excel, 

ActiveX Scripts, Crystal Reports, Windows Scripting, IIS web applications (ASP 

and ASP.NET) by using the Minisoft OLE DB Provider. 

Other Products 

Minisoft also provides Middleware that permits MPE calls from client systems to your 

host data using the familiar TurboImage and MPE intrinsic calls. Please contact your 

Minisoft sales office for details on MiddleMan if you need this option.  

For those customers needing concurrent access to their existing host based applications, 

Minisoft provides a variety of terminal emulation packages on many different client 

platforms including; Windows, Pocket PC, Mac OSX, and java enabled browsers.  
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2. How it works 

Environments 

The choice of installation files and procedures will depend on your operating 

environment. The product is provided as a client/server application. Clients are the 

system used to present the data. Servers are the system used to store the data. A common 

configuration would be an MPE Server with an Image database being accessed by a 

Windows Client running MS Excel. You may also access data on a UNIX or Windows 

server with an Eloquence database from Windows, Mac, or UNIX clients. 

With proper licensing, there are many combinations of clients and servers which will 

enable you to access your information. Please contact Minisoft for a current list of 

supported platforms or to request support for an additional platform. 

Components  

Minisoftôs ODBC/32 product consists of three components: the server, client, and 

administrative tools along with documentation.  

Server 

The Server component is installed on the system where the database resides. The server 

will run in background or foreground processes and listen on one or more TCP ports. 

Licensing information for both the server and clients are stored on the server.  

An instance of the server process is launched for each connection made by a client. The 

process runs its own security context. 

On MPE/iX based systems, the server is run from a common Minisoft background 

process (MSJOB). On UNIX based platforms, the server is usually run from inetd. A 
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Windows service has been created to control the server as a set of background processes 

on Windows Servers. The server may also be run from a shell, command prompt, or 

script. 

Client  

The Client component is installed on the system where the ODBC/JDBC/OLDEB calls 

are made. This can be a workstation running Access, Excel or Crystal Reports. It could 

also be an application server running, for example, SQL Server, IIS, or Oracle. Clients 

for ODBC can be Windows, Mac OSX, Sun, AIX, HPUX, or Linux. OLE DB is 

currently available only on Windows. JDBC can run from any Java 5 or later system on 

your network.  

Administrative Tools  

The installation of Administrative Tools is optional. They are installed on any currently 

supported Windows desktop operating system.  

These tools consist of the Schema Editor and the Catalog Editor. The Schema Editor (see 

page 51) provides for control of the data type and name mapping. The Catalog Editor (see 

page 74) provides very fine control of access to tables and items. 

Documentation  

The primary reference will be this manual. The Minisoft web site 

(http://www.minisoft.com) will contain updates, addenda, samples, and other pages of 

interest.  

http://www.minisoft.com/


     Page | 17 

 

 

3. Installation 

Sources  

From our web site   

After registering, you can download the required files based upon the client/server 

environment you will be using.  

The current version of this manual is stored at our web site in PDF format. 

Optional Media  

Our products can be shipped on CD or other media for off-net installation. 

Installing Servers  

Installing the server  application on MPE/iX  

Installation only needs to be done from one PC ï not each individual PC. No terminal 

emulator is needed for this installation. You must have ñSystem Managerò permission to 

do this.  

The installation is in two parts. The first is a common set of files used by all Minisoft 

Servers (ODBC/JDBC/OLEDB/MiddleMan). The other is an application specific server.  

Installing the MSJOB files on MPE/iX 

Run ñinstall_msjob.exeò from a Windows based PC. Follow the on-screen prompts. 

Installing the Server s on MPE/iX 

Run ñinstall_odbc####.exe from a Windows based PC. Follow the on-screen prompts. 
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Installing the server application on HPUX  

Installing server files 

1. Place all files in the /opt/minisoft directory. Be sure that the directory is readable and 

executable from public. 

    

2. Create a symbolic link to your system specific Eloquence library. Choose the ONE best 

library that matches your HPUX system. 

 
/opt/eloquence6/lib/pa11_32/libimage3k.sl  

/opt/eloquence6/lib/pa20_32/libimage3k.sl  

/opt/eloquence6/lib/pa20_64/libimage3k.sl  

/opt/eloquence6/lib/hpux32/libimage3k.sl  

/opt/e loquence6/lib/hpux64/libimage3k.sl  

 

For example, if you have a newer PA - RISC system, use:  

ln - s /opt/eloquence6/lib/pa20_32/libimage3k.sl \  

 /usr/lib/libimage3k.sl  

   

Configuring system files  

1. Append the following to your /etc/inetd.conf file: 

   

  # 

  # od bcsrvr.exe  

  # 

  odbcsrvr stream tcp nowait root /opt/minisoft/odbcsrvr.exe odbcsrvr.exe 

/S  

  # 

  # odbcsrvr.exe with trace enabled  

  # 

  #odbcsrvr stream tcp nowait root /opt/minisoft/odbcsrvr.exe odbcsrvr.exe 

/S /T  

     

2. Append the following to your /etc/services file: 
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  # 

  # Minisoft odbcsrvr.exe  

  # 

  odbcsrvr 30006/tcp  

 

    

3. Append the following to your /etc/pam.conf file: 

   

# 

# PAM configuration  

# 

odbcsrvr.exe auth required /usr/lib/security/libpam_unix.1  

odbcsrvr.exe account optional /usr/lib/secu rity/libpam_unix.1  

odbcsrvr.exe password required /usr/lib/security/libpam_unix.1  

# 

    

4. For sam to work without error, append /opt/minisoft to the end of 

(/var/sam/ts/pam_dir.reg). 

   

5. Report the System ID and System Name (see license.exe below) to your Minisoft sales 

office. Follow the directions returned to license the product. 

    

6. Restart inetd using the command: 

   
#inetd - c  

Getting information  for licensing  

Please report the value from this utility so that a License Number can be generated for your 

system. 

This is a HP-UX (11) executable.  Place it in the directory "/opt/minisoft". When run, it should 

display the System ID and System Name: 

#/opt/minisoft/license.exe  

System ID = [541750568]  

System Name = [HP - UX B.11.00 9000/800]  
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Use one of the following p arameters:  

1 -  View license information  

2 -  License a product  

5 -  Create license file  

6 -  View license for a product  

#  

Send this information to your Minisoft sales representative. When you receive your reply, follow 

the following directions: 

1. Create an empty license file: 

#cd /opt/minisoft  

#touch MSLICFIL  

#./license.exe 5 " your company name "  

# 

2. Execute /opt/minisoft/license.exe with the parameters as supplied in the reply. 

#/opt/minisoft/license.exe 2  

System ID = [1234567890]  

System Name = [HP - UX B.11.00 900 0/800]  

Product ID to License ? 4 

User Limit ? 0 

Expiration Date ? 20071201  

Extension code ? 1976153532  

# 

Installing the server application on Linux  

Installing server files  

 

Installing the server application on Windows  

Installing server files  
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Installing Clients  

Installing the Minisoft ODBC/32 driver  

Windows 

You must install the Minisoft ODBC/32 PC client on each network PC that will be 

running ODBC/32. To do this: 

1. Execute odbcxxxc.exe from your ODBC/32 CD. 

2. This must be executed on every Windows client that will be accessing data 

on the server.  

Mac OSX 

AIX 

HPUX 

Linux 

Solaris 

Installing the Minisoft JDBC driver  

JDBC connections require two client components. The first is a jar file which contains 

the ñclassesò used by your Java applications. The second is a native application 

component. The native component can be used as a shared library on the same system as 

the jar file or as a Mid Tier Listener on the client, the server, or a third box. The primary 

need for a Mid Tier Listener or three tier approach will be when the java application is 

run inside a browser. The Mid Tier would in those cases be on the web server used. This 

configuration reduces ñsandboxò issues with java network communications. 
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Jar file 

Shared Library  

Mid Tier Listener  

Installing th e Minisoft OLE DB data provider  

 

Installing the Administrative Tools  

Installing Minisoft ODBC/32 PC Administrator  

Note that the administrative tools installation is not necessary to run any of the clients. 

1. Execute odbcxxxa.exe.  

2. Follow the on screen instructions. 

ODBC/32 Deployment 

The following instructions detail methods to distribute the Minisoft ODBC/32 driver to 

multiple workstations after completing your development. You should review the items 

listed below and choose the distribution scheme that best suites your environment: 

 Web server deployment 

 Development for each desktop 

 Reporting tools (Crystal Reports, Access, Excel, etc.) 

Note: Be certain to use the same driver version for all clients. The MSJOB background 

process has the capability to operate multiple versions of each driver to aid in managing 

future driver upgrades. 

Web server deployment  

Install ODBC/32 client on your web server(s) by executing odbcxxxc.exe from your CD 
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or via the web. 

If you are using DSNs to access the ODBC driver, create a System DSN. Web servers 

usually operate without a current user. The DSN must be available to system level 

processes. Do not use question marks (?) in DSN fields. User interaction is not possible 

from the browser to complete the connection request. Use care in protecting the server as 

passwords are stored (encoded) in the system registry. 

If you have included the information needed for the ODBC driver to connect to your 

database as either File DSN or SQLDriverConnect data, you should be able to use the 

driver with no further steps. 

Development for each desktop  

Install the ODBC/32 client on each system where the application will be running by 

executing odbcxxxc.exe from your CD or via the web.  

If you are using DSNs to access the ODBC driver, create a User or System DSN. Use 

question marks (?) in the DSN fields if needed. User interaction would be required to 

complete the connection and no passwords would need to be stored in the system 

registry. 

If you have included the information needed for the ODBC driver to connect to your 

database as either File DSN or SQLDriverConnect data, you should be able to use the 

driver with no further steps. 

Reporting tools  

Install the ODBC/32 client on each system where the reporting tools will be used by 

executing odbcxxxc.exe from your CD or via the web.  

If you are using MSOfficeô97, you will need to create a File DSN. Most other products 

can use any type of DSN including User and System. 

Upgrading ODBC/32  

Obtain the files to upgrade your ODBC/32 from our web or FTP site. Navigate to 
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www.minisoft.com. Under Middleware select ODBC. Select ODBC Updates. Select the 

updates that best fit your deployment. 
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4. Client Configuration 
ODBC data sources are generally configured through an ODBC Data Source 

Administrator. This is part of the Windows operating system. For UNIX systems, you can 

use the Data Source Administrator that is part of unixODBC or iODBC. Application 

properties can also be used to configure data sources. 

JDBC data sources are configured through either a URL or application properties. These 

two options are available when using most off the shelf applications or writing your own 

application.  

An OLE DB Data Provider is configured through the application using it. Both the 

OLE DB data provider and ODBC driver use a common set of Windows dialog boxes. 

Configuring a data source 

To configure a data source with Windows ODBC Data Source Administrator: 

1. Select your PCôs Start Menu and click Settings >Control Panel. In the 

Control Panel dialog box, select ODBC Data Source. 

2. The ODBC Data Source Administrator window appears as shown in 

Figure 1. Select the User DSN tab if it has not already been selected, then 

click the Add button. 
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Figure 1 

3. The Create New Data Source dialog box appears as shown in Figure 2. 

Select HP3000 Data Access Driver if it has not already been selected. Click 

the Finish button. 

 

Figure 2 
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4. Minisoftôs HP3000 Data Access ODBC Driver dialog box appears as shown 

in Figure 3. The ODBC Driver dialog box collects together all the 

information needed to configure ODBC/32 for a given application. You must 

fill in the Data Source tab, Connection tab, at least one database reference, 

schema reference or Self-describing file reference in order to create a Data 

Source Name (DSN). 

 

Figure 3 

5. Under the Data Source tab, fill in the Data Source and Description fields. 

This information will appear in the list of available ODBC sources in your 

database application. 

 

Note: This information is valid for this computer. Choose a name for the 

Data Source that will help you remember it and find it later. Useful ideas are 

the name of the main database you wish to access or the MPE group the files 

resides in. 

6. Click the Connection tab in the Minisoftôs HP3000 Data Access ODBC 

Driver window. The display changes to as shown in Figure 4. 
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Figure 4 

7. At the Server Name field, enter your HP e3000 Server Name or IP address. 

For Server Port, use 30006. 

8. Fill in the Login fields with the appropriate HP e3000 user information for 

accessing your database (this information is required to verify your access 

rights to the requested database). Use a session name (Security/3000 user 

name) in the Job Name field to allow user identification. 

9. Click the Security tab. The following screen appears as shown in Figure 5. If 

you are using VESOFTôs Security/3000, you should configure the session 

user password on the Security tab.  

 If you are using a rotating password, the password will always be the first 

one entered when setting up the user. If a ó?ô is entered in the password field, 

the user will be prompted at runtime for a password. 

 A Catalog is another way to limit access to your data. Using the Catalog 

Editor (see Chapter 7), individual or groups of users can have access 

restricted down to the item level. 

 The Catalog User is either the MPE/iX user and account or the Windows 

logon name. If security is to be based on the Windows logon name then 

ó<WINUSER>ô is entered in the user field, otherwise the field is left blank. 
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 The catalog password field is reserved for future use. Leave this blank. 

 If you do not use Security/3000 leave the Security/3000 field blank. 

 

Figure 5 

Using Schema Editor Files  

Note: You must choose at least one Database reference, Schema reference or Self-

describing file reference. You may choose more than one or all three. If you define the 

same database in both places for the same DSN, you will open the database twice. You 

should NOT add the same name for both a Schema and Database reference. 

1.  If you have or intend to define a Schema file using the Schema Editor, click 

the Schemas tab in the Minisoftôs HP3000 Data Access ODBC Driver 

window as shown in Figure 6. 



     Page | 30 

 

 

Figure 6 

2.  Click Add Schema to enter the name of your schema file. You must have a 

Schema file to define the record layout for MPE and KSAM files. 

3.  The Add/Configure Schema will display as shown in Figure 7. Enter the fully 

qualified MPE file name and Lockword (if needed) for the Schema file 

created with the Schema Editor. Then click OK. 

 

Figure 7 

4.  A Schema file maybe needed for a TurboImage database for redefining items 

in a database such as: item name, length, type, extracting substrings, or date 

format manipulation. See Chapter 6 Schema Editor for details on defining a 

file using the Schema Editor. 

Using database files 

Note: You must choose at least one Database reference, Schema reference or Self-
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describing file reference. You may choose more than one or all three. If you define the 

same database in both places for the same DSN, you will open the database twice. You 

should NOT add the same name as both a Schema and Database reference. 

1. If you intend to define a database, click the Databases tab in the 

Minisoftôs HP3000 Data Access ODBC Driver as shown in Figure 8. 

 

Figure 8 

2. Then click Add Database. 

3. The Add/Configure Database window will appear as shown in Figure 9 

4. Enter your fully qualified MPE Database Name and Password and select 

the appropriate Type and Open mode as shown in Figure 9. Click the OK 

button. 

(If you are unaware of the database password, see Using DBUTIL to find 

database passwords on page 148.) 

Note: Passwords for your TurboImage database are case sensitive. 
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Figure 9 

Using Self-describing files  

Note: You must choose at least one Database reference, Schema reference or Self-

describing file reference. You may choose more than one or all three. If you define the 

same database in both places for the same DSN, you will open the database twice. You 

should NOT add the same name as both a Schema and Database reference. 

1. If you intend to define a Self-describing file, select the Self-describing files 

tab from the Minisoftôs HP3000 Data Access ODBC Driver. Then click Add 

File as shown in Figure 10. 
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Figure 10 

2. The Add/Configure Self-describing File dialog box displays as shown in 

Figure 11. 

3. Enter your file name and password and select the appropriate options for 

configuring your self-describing file. 

 

Figure 11 

Using Translation Tables with ODBC/32  

For conversion between different character sets on the HP e3000 server and the PC client, 

ODBC/32 uses character set translation tables. For more details on these settings and 

files, see Translation Tables on page 43. 

To configure the respective conversion: 

1. Select the Language tab in the ODBC Driver Configuration window as shown in 

Figure 12. 

2. Enter the name of the existing .tbl translation table in the DSN configuration 

dialog box. 

3. After filling out needed information in Minisoft HP3000 Data Access ODBC 

Driver dialog box, click OK. Open your database program and the ODBC data 

source should now be available. 
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Figure 12 

Advanced Options  

 

Figure 13 

This tab (Figure 13) shows the advanced options available. The following table shows the 

mapping to the Connection Properties defined on page 37. 
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Lock retries ï LockRetries 

Century split year ï CenturySplit 

Disable HP3000 transactions ï DisableTxns 

Enable item-level locking ï ItemLocking 

Use standard SQL join processing ï StandardJoins 

Auto-commit ON is the default ï AutoCommitDefault 

All warnings are treated as errors ï WarningsAreErrors 

Max Cache ï MaxCacheSize 

Max Write ï MaxWriteSize 

BigInt as Char ï BigIntAsChar 

Trace Sys/Log Level ï TraceSysLevel/ TraceLogLevel 

Trace Flush Writes ï TraceLogFlush 

Trace Log File Name - TraceFileName 

Creating a Standalone File DSN 

Create a File DSN for users who will not need to learn the ODBC Administrator. The 

information entered in a File DSN is the same general information that would be entered 

when creating a User or System DSN in the ODBC/32 Administrator. You can specify 

the same parameters in a FILE DSN (See Connection Properties on page 37). 

Standalone File DSN Example 

The following is an example of a File DSN that includes connection, database and table 

information. 

Note: All names are case sensitive.  

[ODBC] 

2DriverTable= 
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2HostTable=CUSTOMERS 

DecimalPoint=. 

Description=Sample VB created DSN 

Language=-1 

Server=000.000.000.000 

Server Port=30006 

User=MGR 

User Password= 

Account=MINISOFT 

Account Password= 

Group=MM 

Group Password= 

Jobname=ODBC 

Security Password= 

Catalog User= 

Catalog Password= 

Schema0=TESTSCH.MM.MINISOFT, 

ImageDatabase0=MSCARD.MM.MINISOFT,DO-ALL,N,5,0 

SDFile0=TESTSUB,LOCKIT,2,3,0 

LockRetries=1 

DisableTxns=NO 

ItemLocking=ENABLED 

StandardJoins=YES 

WarningsAreErrors=NO 

AutoCommitDefault=ON 

CenturySplit=50 

SQLDriverConnect 

SQLRETURN SQLDri verConnect( 

SQLHDBC ConnectionHandle, 

SQLHWND WindowHandle, 

SQLCHAR * InConnectionString, 
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SQLSMALLINT StringLength1, 

SQLCHAR * OutConnectionString, 

SQLSMALLINT BufferLength, 

SQLSMALLINT * StringLength2Ptr, 

SQLUSMALLINT DriverCompletion); 

Where InConnectionString defined with properties separated with semicolons (See 

Connection Properties on page 37). 

ñDRIVER=HP3000 Data Access Driver; 

Database0=MSDB.DEMO.MINISOFT,WRITER,N,1;  

Server=000.000.000.000;Server Port=30006;  

Jobname=MSJOB;User=MGR;User Password=PASSWORD;Account=MINISOFTò 

Connection Properties 

This is a list of the common connection properties used by ODBC, JDBC, and OLE DB. 

2DriverTable  

String Value 

This string defines the read Translation Table file. See Translation Tables on page 43. 

2HostTable 

String Value 

This string defines the write Translation Table file. See Translation Tables on page 43. 

Account 

String Value (Server Type 0 only) 

Enter the HP e3000 logon account. 

Account Password  

AccountPassword 

String Value (Server Type 0 only) 
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Enter the HP e3000 logon account password. 

AutoCommitDefault  

Enter ON or OFF. 

Default state for the connection whether an INSERT, UPDATE or DELETE transaction 

should be committed. 

BigIntAsChar 

Contact Minisoft support before changing this value. 

Some applications cannot correctly handle very large values as numbers. With this flag 

set, all columns that would normally be represented as SQL_BIGINT are converted to 

character and seen as SQL_CHAR. 

Catalog Password 

CatalogPassword 

Deprecated 

Catalog User 

CatalogUser 

Enter the windows user or leave this parameter blank. 

CenturySplit  

Enter a year for windowing dates. 

Used for conversion between 2digit years and 4digit years. 2digit years less than the 

number will have 2000 added. 2digit years greater than or equal to the number will have 

1900 added. 

Database<n> 

Deprecated ï Use ImageDatabase<n>. 

DecimalPoint  

Insert a character for use with a decimal place. 
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Description  

This is an optional descriptive text string. 

DisableTxns 

String Value (YES or NO) 

Default ñNOò 

The use of the MPE Transaction Manager (XM) may be disabled with the DisableTxns 

registry entry. If set to No, ODBC/32 will use XM when executing UPDATES, 

DELETES, and INSERTS. If set to Yes, ODBC/32 will not use XM when executing 

UPDATES, DELETES, and INSERTS. This should only be used when an UPDATE, 

DELETES, or INSERT statement causes the XMôs log file to fill up. 

Note: When DisableTxns is set to Yes, a rollback cannot be done if the statement 

encounters an error or the system goes down. All records modified up to that point will 

remain modified. 

Domain 

String Value (Server Type 2 only) 

DSN 

Data source name. 

Group 

String Value (Server Type 0 only) 

Enter the HP e3000 logon group. 

Group Password 

GroupPassword 

String Value (Server Type 0 only) 

Enter the HP e3000 logon group password. 
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IgnoreUIDPWD 

This setting is used with calls from applications which pass the unnecessary user name 

and password as API parameters.  

ImageDatabase<n> 

<database name>,<database password>,<load auto master flag Y/N>,<database open 

mode>,<suppress TPI suffix> 

ItemLocking  

String Value (ENABLED or DISABLED), case insensitive 

Default ñENABLEDò 

The DSN registry variable óItemLockingô controls whether item-level locking will be 

used. The default enables item level locking when possible. Any value other than 

óENABLEDô will cause all locking to be done at the set level. This is necessary when 

error -222 (Descriptor list exceeds 4094 bytes) is returned from TurboImage. This 

typically happens when an INSERT, UPDATE, or DELETE statement is executed many 

times, or many statements are executed within one transaction. 

Examples: 

ItemLocking=òENABLEDò 

Enables item level locking. 

ItemLocking=òDISABLEDò 

Forces set level locking. 

If  an UPDATE or DELETE (detail datasets only) statement has a where clause that 

specifies an IMAGE key with an ó=ô relational operator or a BTREE key with ó=ô, ó<=ô, 

or ó>=ô relational operators, the locking statement will be at the item level using the key 

item and the associated value and relational operator. For INSERT statements on detail 

datasets, the first item in the item list and its value will be used for the lock. 

Jobname 

String Value (Server Type 0 only) 
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Enter the Job name. 

Language 

This value is used for sort order processing on the server. If left at default, the server is 

queried for the appropriate language to use.  

LockRetries 

Enter a number or enter the default number 1. 

Specify the number of times to retry a conditional lock. If set to 0, unconditional locking 

will be used. The order locks are applied, are determined by the order of the SQL 

statements in the transaction. 

Note: Never use unconditional locking when locking multiple databases and/or files, 

unless all applications apply the locks in the exact same order.  

MaxCacheSize 

Contact Minisoft support before changing this value.  

This can affect the size of the read-ahead buffer used when sequentially fetching records. 

MaxWriteSize  

Contact Minisoft support before changing this value. 

This will affect the size of the network buffers used in communicating with the host. It 

may be changed if there are network latency or router difficulties. 

Schema<n> 

<schema file name>,<lockword> 

SDFile<n> 

<filename>,<lockword>,<type>,<foptions>,<aoptions> 

 For value type: 0 = Query SD file 

   1 = Robelle SD file 

   2 = QUIZ Subfile 

 Note: Refer to HP documentation for values for foptions and aoptions. 
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Security Password 

SecurityPassword 

Enter your security 3000 password. 

Server 

Enter the server IP Address or Hostname. 

Server Port 

ServerPort 

Enter the server port, default is 30006. 

Server Type  

ServerType 

 0 = MPE 

1 = UNIX (HPUX, Linux) 

2 = WindowsÊ 

StandardJoins 

Enter YES or NO. 

StandardJoins=òYESò, cause inner joins to be done as the SQL standard requires. All 

new DSNs will have this set to ñYESò. If the setting does not exist or is anything other 

than ñYESò (case insensitive) the existing inner join logic will be used. 

TraceFileName 

Contact Minisoft support before changing this value. 

See Tracing Facilities on page 141. 

TraceLogFlush 

Contact Minisoft support before changing this value. 

See Tracing Facilities on page 141. 
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TraceLogLevel 

Contact Minisoft support before changing this value. 

See Tracing Facilities on page 141. 

TraceSysLevel 

Contact Minisoft support before changing this value. 

See Tracing Facilities on page 141. 

User 

user 

UID 

Enter the HP e3000 user logon. 

User Password 

UserPassword 

password 

PWD 

Enter the HP e3000 user password. 

WarningsAreErrors  

Enter YES or NO. 

Some clients use SQLSetStmtAttr to set the maximum size for a result set. If this size has 

been exceeded an error message will be generated unless the registry entry 

ñWarningsAreErrorsò for the data source is set to ñNOò. Reaching the row limit set by 

the client with SQLSetStmtAttr will no longer cause this error. Reaching the row limit set 

in MSJOB with the MSQUERYRECLIMIT variable will still trigger the error as 

intended. 

Translation Tables 

Translation tables provide a means to substitute characters during ASCII data transfers. 

These tables are available from Minisoft, Inc. Contact Minisoft to receive the table(s) you 
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need. You may also create you own tables. 

To obtain proper conversion of data from the MPE server system to your Windows based 

software on the PC client, install the tables as directed on your system(s). From the table 

shown in Table 1, select the conversion table that corresponds to your environment. 

Server Character Set Client Character Set Host->Driver  Driver ->Host 

ROMAN8  Windows ANSI ROM8ANSI.TBL ANSIROM8.TBL 

LATIN2  Windows ANSI LAT2ANSI.TBL ANSILAT2.TBL 

ISO 7bit DANISH/NORWEGIAN  Windows ANSI DAN7ANSI.TBL ANSIDAN7.TBL 

ISO 7bit FINNISH/SWEDISH  Windows ANSI FIN7ANSI.TBL ANSIFIN7.TBL 

Table 1 

Note: The above files are the same as those used with other communication products. 

Making XLAT Files 

The size of these tables is always 256 bytes. The characters in this file are substituted for 

the equivalent (indexed) character requested. If the file contains the sequential binary 

values zero through 255, no change would effectively take place. 

Example: 

If the 33rd character (Decimal value 32, Hex 20) is replaced with the 66th character 

(Decimal value 65, Hex 41), all blank spaces will be replaced with the letter A. 
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5. Server Configuration 

Common Options 

How options are configured  

You may configure the servers either through startup parameters or environment 

variables. 

Startup Parameters  

Startup parameters are characters or combinations of characters included on the 

command line or in a startup parameter field. While the format of these parameters is 

common for all servers, operating system specific details may vary. 

 S ï Secure Logon 

 W - Write 

 R ï Row ID 

 U - Allow CIUPDATE 

 H ï Host Commands 

 C ï Catalog Security 

 F ï Full Read 

 T ï Tracing 

 P ï Port Number 

 N ï Native Library 

 V ï Version Information 

 E ï Environment File 

Configuring for Secure Logon access (S) 

The servers are shipped with the ñSò parameter in place. This option prevents access 

should the logon information be invalid. Do not remove this option without 

understanding that access will be granted to your data based upon the default user for the 
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connection. 

Configuring for Write access (W)  

As shipped, the server will allow read-only access to databases and files. If you wish to 

permit writes and updates to files and databases, you must first modify the startup 

parameters to include the letter ñWò. 

For example: 

SETVAR MSSERVER000004 ñ30006 0 ODBCSRVR.MM.MINISOFT Sò 

Becomes: 

SETVAR MSSERVER000004 ñ30006 0 ODBCSRVR.MM.MINISOFT S Wò 

Configuring fo r ROWID (R) 

This adds a virtual column of integers representing the current row number of the row in 

the image database. This is a read only value. The value returned may be changed by 

other applications that access the database at any time. Do not reply on this value to 

persist. 

Configuring for CIUPDATE (U) 

When set, all DBOPEN are followed by a DBCONTROL to enable Critical Item Update 

(CIUPDATE). This will succeed for databases that are configured to ñallowò 

CIUPDATE.  

Configuring for Host Commands (H) 

 

Configuring for Catalog Security  (C) 

In order to use the extra security checking of a catalog file, the óCô parameter must be 

added to the startup parameters.  

A catalog file must then be created with the Catalog Editor and uploaded to the server. 

By default the server program looks for a file named ODBCCAT in the login group of the 

user. You can use multiple Catalog files if users are logging into different groups. 

Optionally, on MPE systems a file equation may be placed in MSJOB before the run line, 
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to specify a single catalog file for all users. 

Configuring for Full Read  (F) 

Enabling FullRead, by placing an ñFò in the startup parameters, prevents the server from 

optimizing certain select SQL statements. Many client applications will issue ñselect * 

from tableò statements with a series of sequential fetches. The servers can optimize this 

type of statement without affecting the outcome of the result set. Please contact Minisoft 

support if you feel this optimization should be disabled on your system.  

Configuring for Tracing  (T)  

For more details, review ñTracing Facilitiesò on page 141. 

Port Number  (P) 

 

Native Library  (N) 

When this is set, the native eloqdb library is used in place of the Image3k library. 

NATIVE_ELOQ is a synonym for the óNô startup parameter. 

Version Information  (V) 

 

Environment File  (E) 

 

Environment Variables  

These values are used for more complex or universally applied configurations. On MPE 

systems they are set with the SETVAR command in the job or session which holds the 

listener process. UNIX and Windows servers read the shell variables. UNIX and 

Windows servers may also reference a port specific file of environment variables for 

added flexibility.  

 MSQUERYRECLIMIT 

 MSQUERYCPULIMIT  
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 MSQUERYCHECKINTERVAL 

 MSDECADEDIGITS 

 MSTRACESTATEMENT 

 TraceSysLevel 

 TraceLogLevel 

 TraceLogFlush 

 TraceFileName 

 ROBELLE_SD_TYPE 

 NATIVE_ELOQ 

MSQUERYRECLIMIT 

MSQUERYCPULIMIT 

These variables are used to limit queries If you need to limit the time or disc space 

affected by ODBC, add one or both of the following statements to your MSJOB file 

(before the RUN command): 

!SETVAR MSQUERYRECLIMIT 1024 

!SETVAR MSQUERYCPULIMIT 20  

Maximum records per query set with MSQUERYRECLIMIT is in records <records>. 

Maximum cpu time per query set with MSQUERYCPULIMIT is in seconds <seconds>. 

If either limit is reached, your action will be terminated with an error. 

MSQUERYCHECKINTERVAL 

This will set the minimum time in seconds between network client checks. Used during 

sort and select operations to verify the client is still attached. The default is 60 seconds.  

MSDECADEDIGITS 

Text array used to handle those server applications that choose to use óA0ô to represent 

the year 2000.  

MSTRACESTATEMENT 

Setting this will write the SQL statement being processed by the client to the current log 

file regardless of the TraceLogLevel. 
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TraceSysLevel 

TraceLogLevel 

TraceLogFlush 

TraceFileName 

ROBELLE_SD_TYPE 

NATIVE_ELOQ 

When this is set, the native eloqdb library is used in place of the Image3k library. 

NATIVE_ELOQ is a synonym for the óNô startup parameter.  

MPE Specific 

Modifying SETVAR statements  

Modify MSJOB by changing the lines as follows: 

SETVAR MSSERVER000004 ñ30006 0 ODBCSRVR.MM.MINISOFT Sò 

To enable write / update access, modify the command line to include the ñwò (write) 

option: 

SETVAR MSSERVER000004 ñ30006 0 ODBCSRVR.MM.MINISOFT S Wò 

You can now stream MSJOB.MM.MINISOFT, the listener on the HP e3000. 

Using Indirect files  

Some customers use indirect file references to configure the servers. If you see lines that 

appear as follows in your MSJOB file, you will need to modify the referenced file. 

SETVAR MSSERVER000004 ñ^ODBC0001ò 

In the case shown above, the indirect file is ODBC0001 in the current group.account for 

the current job. Changing the write access requires changing the line 

30006 0 ODBCSRVR.EXE.MINISOFT;STDLIST=*LP;PRI=CS S  
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to 

30006 0 ODBCSRVR.EXE.MINISOFT;STDLIST=*LP;PRI=CS S W  

 

UNIX Specific 

inetd  
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6. Schema Editor 

Introduction 

The Schema Editor is used to create and edit ñschemasò. Schema files are saved in .XML 

format on the local PC and then uploaded to the HP e3000 for use by the end user. 

Schema files contain descriptions of a variety of files: TurboImage databases (derived 

from the databases themselves), KSAM files, MPE files, Cognos PDL files; and self-

describing files generated by such programs as HP Query, Robelle SUPRTOOL and 

Powerhouse subfiles. Schemas can be included in a datasource on the Schema tab of the 

Data Source Configuration dialog box of the ODBC/32 Driver. Schemas can consist of a 

single TurboImage database or multiple KSAM, MPE, or self-describing files. 

Note: Do not confuse schemas created and edited in Minisoftôs Schema Editor with the 

schema files created with a text editor on the HP e3000 and used by 

DBSCHEMA.PUB.SYS to create the TurboImage root file. While both schema files 

contain similar information, they are quite different in practice. 

KSAM and MPE files must be described with the Schema Editor to be accessible through 

ODBC/32. TurboImage databases may be redefined with the Schema Editor to change 

the way they are presented through ODBC/32. Commonly, you may need to redefine a 

character or numeric type as SQL_DATE. TurboImage item names with any special 

character other than the hyphen (-) must be given an alias name to be accessed. 

Adding a new item requires you to use the Schema Editor. Some items are composed of a 

number of sub-elements. By adding an item, you can access any portion of the Record 

Buffer as any data type. 

The Schema Editor is executed by clicking Schema Editor in the Minisoft program group. 

Its main screen is shown in Figure 14: 
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Figure 14 

Schema Editor Menu Bar Definitions  

File Menu 

New -Allows you to create either a blank schema used for KSAM, MPE, or self-

describing files or to import the database layout from a TurboImage 

database.  If you choose the later you will be prompted to enter the Database 

name, Password, and open Mode.  Normally the óLoad Automatic Mastersô 

checkbox is not selected.  Remember the database password is case sensitive. 

Open - Allows you to open an existing schema file already saved on your PC.  

Schema files are saved in .xml format and by default have an .xml suffix. 

Open Remote - Allows you to open a schema file saved on your HP e3000.  You 

are prompted for the name of the schema file and the group and account, and 

the lockword if there is one.   

Import PDL File - This option allows you to import a Powerhouse data diction-

ary source file.  The source file can either reside on the HP e3000 or as a 

local file on your PC.  If it is on the HP e3000, enter the name of the PDL file 

in the Dictionary field, the group and account, and lockword if there is one.  

If the file has been downloaded to your PC, check the óUse local fileô box 

then enter the full path name into the Dictionary field.  Processing is faster 

with a local file but not significantly so. 
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Connection Menu 

Load - Allows you to open a saved configuration file.  

Save - Allows you to save a connection configuration file.  

Edit - Allows you to edit a connection configuration file. 

 

 

Connection to your HP e3000 

The Schema Editor stores its ñschemasò as .XML files on your local PC and optionally 

on the HP e3000. Upload your schemas to the HP e3000 before using.  

The Schema Editor needs connection configuration information to make connections to 

the HP e3000. To add the connection configuration information select Connection - Edit 

from the main menu in the Schema Editor. The Connection Configuration dialog box 

displays as shown in Figure 15. 

 

Figure 15 

1. Enter your HP e3000ôs IP address or host name in the Server Name field. 

2. The Server Port field default value is 30006 and is typically never changed. 

3. Enter valid login information in the following fields. 
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4. Optionally, click the óLoadô button to load a saved configuration file. 

5. When finished press OK, and select Connection > Save from the Schema 

Editors main menu to save the connection configuration for later use. 

Note: You can automatically load this connection configuration when the Schema Editor 

starts by including the file name of the connection configuration on the command line for 

the Schema Editor icon. 

Opening a Schema Editor file 

File > Open 

This menu option allows you to open an existing schema file saved on your PC.  Schema 

files are saved in .xml format and by default have an .xml suffix. Select File > Open. The 

Open Schema dialog box appears as shown in Figure 16. 

 

Figure 16 
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File > Open Remote 

With MPE systems, you are prompted for the name of the schema file and the group and 

account, and the lockword if there is one. See Figure 17. For UNIX and Windows based 

systems, you will enter the path and file name where the Schema Editor file is located. 

See Figure 18. 

 

Figure 17 

 

Figure 18 

Saving a schema 

3. From the file menu select Save or Save As to save your schema to your PC.  

4. To save and then upload your schema file to the HP e3000, select File > 

Save and Upload. When selected, the Save Schema dialog box appears as shown 

in Figure 5-15. 
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5. Name the file to store the Schema in by filling in the Schema and Group and 

Account fields.  Note: You must be logged into the account specified and have 

write and save access to the group and account in order to save the Schema file to 

the HP e3000. 

 

Schema - Name of the schema file. Only valid HP e3000 names are allowed. 

Group and Account - The group and account to save the schema file. For fewer 

problems, try to save the schema file in the account where data resides. 

Lockword - Optional. Enter a lockword to prevent unauthorized access to the 

schema file. 

Creating a Schema for KSAM and MPE files 

To create a new schema, select File > New. The New Schema dialog box appears as 

shown in Figure 5-3. 

1. Select one of two choices when creating a New Schema: 

  Create blank schema  

2. In the Schema name field, enter the name of the file on the HP e3000 that the 

schema will be stored in. Do not include the group and account. 
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3. Once you press OK, the schema appears in the main window as shown in 

Figure 5-4: 

 

Creating a table 

To create and add table definitions to your schema, select Tables > Add from the main 

menu. 

To view and edit table properties, select View > Properties from the main menu. The 

ñFile Table Propertiesò dialog box will then be shown, see Figure 5-5 and Figure 5-6: 

 The Definition tab shows table name, alias, and type. For KSAM and MPE files 

all the above fields can be modified. The alias name, if entered, is the name that 
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will be presented through the ODBC/32 driver: 

 

 The File Open Info tab contains the open information for the file. All the 

following fields maybe changed: 

 

Note: The Table Properties dialog box is modeless, so it will remain on display until you 

explicitly close it with the close button. 

Creating a schema for a TurboImage database 

To create a new schema: 

1. Select the File - New menu.  

2. The New Schema dialog box appears as shown in Figure 19. 

3. Select Create Schema From TurboImage Database and enter the database 

name and password. Then click OK. 
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Figure 19 

4. The Connection Configuration dialog box appear as shown in Figure 5-2. 

Complete the dialog as explained under the heading Connection to your HP 

e3000 and press OK. 

 5. A new schema will be initialized with a description of the database as shown 

in Figure 5-12. 
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Figure 20 

Database Dataset Properties  

The Definition tab shows the Table Name, Alias, Dataset Type, and Lock Item for the 

Image table.  The Alias name, if entered, will be the name presented through the 

ODBC/32 driver.  If a Lock Item is selected, it will be used as the default lock item when 

doing Item Level Locking but only if it is part of the WHERE clause.  

 

The Database Open Info tab contains the Name of the database to open, the database 

password (which is case sensitive), and the database Open Mode.  The most common 
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Open modes are Mode 1 for write access and Mode 5 for read only access.  

 

Note: The Image Table Properties dialog box is modeless so it will remain on display 

until you explicitly close it.  Saving the Schema file saves all changes that have been 

made. 

Creating a schema for Self-describing files 

To reference a DSN: 

1. Start the Schema Editor and create a new blank schema. 

2. From the menu bar select Table > Import self-describing file to import and 

modify the definition. (see Figure 5-13) 
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Figure 5-13 

3. The dialog for self-describing files appears (Figure 5-14), allowing you to 

specify the type of file and how it should be opened. 

 

Figure 5-14 

Adding and editing items 

Note: Item Names for Record Based or Calculated items are Image syntax. Names with 

hyphens must be entered with hyphens as they will appear as underscores in your client 
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application. 

The expression of Calculated items are in SQL syntax. Names of the existing items must 

be entered in converted form where hyphens become underscores. 

Record based 

To add items to a table, select the table from the Schema Editor and select Item>Add 

from the main menu. The Item Properties dialog box will then appear as shown in Figure 

5-7. Use the following dialog box to view and edit the item properties: 

 

Figure 5-7 

Definition tab: 

Item Name and Alias fields: Name of the record item. 

Offset, Data Type and Length fields: Describes type, size, and item location in the 

record. Data Type and Length must be valid TurboImage type and length 

specifications. The size may specify storage that is not an even number of 

bytes. 

 Note: The byte size of the item depends on the Data Type and Length 

according to the rules for TurboImage data items. 

SQL Type field: Specifies the data type that is presented through the ODBC/32 

driver. See Chapter 5  Data conversion for further information on using this 

field. 

Precision field: Specifies the total number of digits contained in a fixed numeric 

data item. Fixed numeric data items have SQL types of SQL_SMALLINT, 
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SQL_INTEGER, SQL_BIGINT, SQL_NUMERIC, and SQL_PACKED. 

Scale field: Specifies how to scale numeric data items of SQL_NUMERIC and 

SQL_PACKED types. The number represents how many places the decimal 

point is moved to the left. 

Keep in mind that the Item Properties dialog box is modeless, so it will remain displayed 

until you explicitly close it, using the close button.  

Adding and editing keys (indexes) - KSAM only 

To add indexes to a table: 

1. Select the table from the main window, and select Indexes > Add from the 

main menu. 

2. Use the View > Index Properties menu to view and edit the index properties. 

Index properties are contained on two tabs on the Index Properties dialog 

box, as shown in Figure 5-9 and Figure 5-10: 

 The Definition tab names the index and specifies a type: 

 

Figure 5-9 

 The Components tab specifies which data items are available to be 

indexed. Select a data item from the Available Items listbox and click the Add 

button to add it to the Component Items listbox: 
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Figure 5-10 

Adding calculated items 

To create a calculated item : 

1. Select Add Calculated Item from the Items menu. 

2. Highlight the new item you created and select the Properties option from the 

View menu. The calculated Item Properties dialog box then appears, as 

shown in Figure 5-8. 

3. Enter an appropriate name in the Item Name field. 

4. Next, define your item with a valid SQL expression. For example: 

  To create a NEW calculated item called TOTAL-DUE that would be the 

difference of items TOTAL-OWED and TOTAL-PAID, the expression 

would be ñTOTAL_OWED -TOTAL_PAIDò. 

 Note: Do not use any special characters in the name of the calculated item. 

The expression must contain valid SQL expressions. 
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Figure 5-8 

SQL Examples 

Note: For lists of supported functions see Appendix D on ODBC/SQL Functions. 

Below are function examples using valid SQL expressions as follows: 

 Enter valid SQL functions: 

 {fn CONCAT(CUSTOMER_NUMBER, CUSTOMER_NAME)} 

 The following function concatenates a name: 

 ({fn rtrim(name _first)} + ó ó + name_last) 

 An 8 character field in the format of yyyymmdd is put into a date format using 

the substring function:  

 ({fn substring(date_opened,5,2)} + ó/ô +  

 {fn substring(date_opened,7,2)} + ó/ô +  

 {fn substring(date_opened,1,4)})  

 In the following three examples, the field address4 has data stored in the format 

of óCity Name, WA 98275ô.  

 To return the city: 

  {fn substring(address4, 1, ({fn locate(ó,ô, address4)} -  1))}  

 To return the state: 

  {fn substring(address4, ({fn locate(ó,ô, address4)} + 2), 2)}  

 To return the zip code: 

  {fn substring(address4, ({fn locate(ó,ô, address4)} + 5), 
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  ({fn char_length(problem_desc)} -  ({fn locate(ó,ô, 

problem_desc)} + 5)))}  

 Note: The  zip code starting point is determined by locating the ó,ô then adding 5. 

How many characters that are returned is determined by subtracting the starting 

point from the total length of the field. 

MPE Data Types 

Use the Image Data Type and Length when defining the type used in Image, KSAM, or 

MPE fields. This reference chart can be used to determine the appropriate type from your 

existing source code. The bytes reference will guide you in determining the width of each 

item so that the offset for the nextiem can be found. 

 

Using Dates 

When changing the SQL type of a data item from its default to SQL_DATE, the 

conversion options will be masked based, value based, or both depending on the original 

Image Data Type. 

Note: Your original Image Data Type will not be changed. 

1. Select an Item to change its default SQL Type to SQL_DATE. 

2. From the Record-based Item Properties dialog box change the SQL type to 

SQL_DATE as shown in Figure 5-18. 
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Figure 5-18. 

 Note: If you do not change the SQL type to SQL_DATE, the Date 

Conversion tab options will not be available. 

3. After selecting SQL_DATE from the SQL type drop down list, click the Date 

Conversion tab as shown in Figure 5-19. 

4. Depending on the original Image Type, you will see the options value-based, 

mask-based, or both in the Internal type field. 

 For value-based type, select an appropriate value format from the options 

listed, as shown in Figure 5-19. 

 

Figure 5-19 

5. For mask-based Internal types, enter year (Y), month (M), and day (D) in the 

appropriate column. For character Image types, you have the option to add 


